RW ENERGY

I rroduct Manual http://www.rw-relay.com

RWH - 151 General Protection Device

Wide applicability

High reliability

Easy to install and maintain

Integration of multiple protection functions

gosEoEuets

Comply with IEC / CEI /GB/JB/DL standards

Provided customized manufacture

Whole solutions for design, assembly, test...

Accountable solution for safety and reliability

Wide range offering, easy business and convenient installation
Version 2025 Copyright RW Energy



Please read this chapter carefully before using this product!

This chapter introduces the safety precautions before using this product. Please
make sure the content of this chapter is fully read and understood before installation
and usage. Our company will not undertake any responsibilities for any damage or
injury caused by improper operations because of ignoring relevant warning in this

operation instruction.

Before operating this device, relevant professional personnel shall read this

instruction carefully and well understand the content.
Operation instructions and warnings:
The following standard definitions will be adopted in this operation instruction.

Danger! Ignoring of safety precautions may cause personal death, serious personal
injury or serious equipment damage.
Warning! Ignoring of safety precautions may cause personal death, serious

personal injury or serious equipment damage.

Caution! Ignoring of safety precautions may cause a slight personal injury or
equipment damage, especially the damage of device or the equipment protected by

the device.
® Danger!

When the primary system is live working, secondary open circuit for the current
transformer connected to the device is absolutely forbidden, and the open of this

circuit may cause extremely dangerous high voltage.
® Warning!

Some parts of the device may have high voltage when the electrical device is running.

Improper operation may cause serious personal injury or equipment damage.

Only qualified professional personnel are allowed to operate the device or work
nearby the device. The operators professional shall well understand the precautions,

working flows and safety regulations mentioned in this instruction.



e Caution!
Grounding terminals of the device shall be firmly grounded.

The device is only permitted to run in atmospheric environment that specified in the
technical specifications, and abnormal vibrations shall be avoided in its running

environment.

When connect the AC voltage current circuit or power circuit, please make sure they

conform to the rated parameters of the device.

When the output terminals of the device are connected to external circuit, please

check carefully the voltage of external power to prevent overheating of the circuit.

Carefully check the cable connected to the device, preventing applying too much

external force on it.
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1.1 Description

General Protection Device is a microprocessor as the core, combined with modern ele
ctronic technology, computer technology, communication technology, to realize the p
ower system fault detection, protection control and operation monitoring function of i
ntelligent equipment. As the key line of defense for the safe and stable operation of t
he power system, it replaces the traditional electromagnetic protection device and si
gnificantly improves the reliability, sensitivity and speed of protection.

The device is mainly composed of data acquisition system, microprocessor unit, input
/output interface, communication module and power module. When working, the dat
a acquisition system collects analog signals such as current andvoltage in real time, a
nd transmits them to the microprocessor after analogtodigital conversion; the microp
rocessor analyzes and calculates the data according to preset protection algorithms a
nd logic programs, and determines whether a fault or abnormality occurs in the pow
er system; once a fault is detected, it quickly drives the circuit breaker to trip and rem
oves the faulty equipment through the output interface and uploads the fault informa
tion to the monitoring center through the communication module. Upload the fault in
formation tothe monitoring center through the communication module.

Support communication protocols: IEC 60870-5-101 IEC 60870-5-

104 Modbus DNP3.01.2 Protection.

1.2 Protection.
49 Thermal Overload (Over load)
50 Instantaneous Overcurrent (Ph.OC)

50G/N/SEF  Instantaneous Sensitive Earth Fault (SEF)
27/59 Under/Qver Voltage (Ph.OV/Ph.UV)
51c Cold load pickup (Cold load)

1.3 Supervision

60CTS CT Supervision
60VTS VT Supervision
1.4 Control
79 Auto Reclose
86 Lockout

CB Control



1.5 Features
Password Protection — 2 levels.

50Hz systems and two phase/three phase wiring method are available, so that the
use scope of device is extended.

Protection configuration is complete, and all protection functions can be switched on
and off flexibly.

4-way intellectual switching value input.

Large capacity flash memory can record at least 100 times of historical events, and
no data will loss even the power is off.

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers,
and the operation is simple and reliable.

The device has complete self-inspection function to in-service monitor the working
conditions of various parts of the device, ensuring the reliability of the device.

1.6 Monitoring Functions

Primary Currents Phases and Earth Direction
Secondary PT Voltage

Frequency

Binary Input/Output status

Trip circuit healthy/failure

Time and date

Fault records

Event records

1.7 Hardware

4CT 1 VT 7 Binary Inputs 2 Binary Outputs
4CT 2 VT 7 Binary Inputs 2 Binary Outputs



1.8 Data Storage and Communication

RS485, RS232, R145 port

Protocols —-IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU
Event Records

Fault Records

Measurands

Commands

Time Synchronism

Viewing and Changing Settings

1.9 RF remote controller

Function of each key
A:Close

B:Trip

C:Unlock

D:Reset

Note:
1. In order to prevent misuse, press the unlock button for 3 seconds, before

execution of the closing operation.
2. The effective distance of RF remote controller is 30 meters.



Chapter 2: Technical Performance Index

2.1 Inputs and Outputs
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Voltage Inputs

Auxiliary Supply

Binary Inputs




2.3 Serial Interface

2.4 Data Storage

2.5 Mechanical Tests

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I

Shock and Bump --- IEC 60255-21-2 Class I

Shock and Bump --- IEC 60255-21- 3 Class I
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Mechanical Classification

Durability >106 operations
2.6 Electrical Tests
Insulation --- IEC 60255-5

Type Level

Between any terminal and earth 2.0 kV AC RMS for 1 min
Between independent circuits 2.0 kV AC RMS for 1 min
Across normally open contacts kV AC RMS for 1 min

High Frequency Disturbance --- IEC 60255-22-1 Class III

Type Level Variation
Common (longitudinal) mode 2.5 kv <5%
Series (transverse) mode 1.0 kV <5%

High Frequency Disturbance --- IEC 60255-22-2 Class IV
Type Level Variation
Contact discharge 8.0 kv <5%

Fast Transients --- IEC 60255-22-4 Class A (2002)

Type Level Variation
5/50 ns 2.5 kHz repetitive 4 KV <5%
Surge Immunity --- IEC 60255-22-5

Type Level Variation
Analog Inputs: 4.0 kV <10%

Line to Earth

Case, Aux Power & I/O: Line to Earth 2.0 kV <10%
RS485 Comms port: Line to Earth 1.0 kV No Data Loss
Analog Inputs: 1.0 kV <10%

Line to Line

Case, Aux Power & I/0O: Line to Line 1.0 kv* <10%

* Note 45ms DTL pick-up delay applied to binary inputs
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Conducted Radio Frequency Interference --- IEC 60255-22-6
Type Level Variation
0.15 to 80 MHz 10V <5%

Radiated Radio Frequency --- IEC 60255-25

Type Limits at 10 m, Quasi-peak
30 to 230 MHz 40 dB(uV)
230 to 10000 MHz 47 dB(uV)

Conducted Radio Frequency

Type Limits

Quasi-peak Average
0.15 to 0.5 MHzZ 79 dB(pV) 66 dB(pV)
0.5 to 30 MHZ 73 dB(pV) 60 dB(pV)

Radiated Immunity --- IEC 60255-22-3 Class III

Type Level
80 MHz to 1000 MHz Sweep 10 V/m
1.4GHz to 2.7GHz Sweep 10 V/m

80,160,380,450,900,1850,2150 MHz Spot 10 V/m
2.7 Climatic Tests
Temperature --- IEC 60068-2-1/2

Operating Range -55°C to +70°
Humidity --- IEC 60068-2-78

Operational test 56 days at 40°C and 93%

relative humidity
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3.1 Function Description
Under Voltage (Ph.UV)

PT voltage is used as the criterion of undervoltage protection. There are two sections
of undervoltage protection here.
Action Logic diagram:

| UAB<Uset H
[ CBinclosed position }———— & Trip

[ ph.uvisrun |

Note: Runis™ v ", Stopis™Xx".
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time

Power on

The device will control the CB to close when the PT voltage greater than pickup
voltage.
Action Logic diagram:

UAB>Uset
| CB in opened position I— & lose

| Power onisrun l[

Note: Runis™ v ", Stopis™Xx".
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time

Over Voltage (Ph.OV)

PT voltage is used as the criterion of over-voltage protection. There are two sections
of overvoltage protection here.
Action Logic diagram:

UAB>Uset
| CB in closed position |— & Trip

Ph.OVis run }

Note: Runis ™ v ", Stopis™X".
UAB—Secondary PT voltage Uset—Pickup voltage T—Delay time



51c Cold Load Pickup (Cold Load)

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered
for a prolonged period, this can impose a higher than normal load-current demand
on the system which could exceed normal settings. These conditions can exist for an
extended period and must not be interpreted as a fault. To allow optimum setting
levels to be applied for normal operation, the cold load pickup feature will apply
alternative current settings for a limited period. The feature resets when either the
circuit breaker has been closed for a settable period, or if the current has reduced
beneath a set level for a user set period.

Action Logic diagram:

[ cold load is Run ———
[T bi| (&7
| Ph.oCisRun [

Note: Runis™ v ", Stopis™Xx".
IA IB IC—Measured current I'set—Cold load pickup current

Iset—Ph.OC pickup current T—Delay time
50P Phase Fault (Ph.0OC)

Three sections phase overcurrent protection for lines include Ph.OC1 (instantaneous
overcurrent protection), Ph.OC2 (definite time overcurrent protection) and Ph.0OC3
(overcurrent protection). All of which are definite time actuate features.

Action Logic diagram:

TA>Iset

IB>Iset ]
J & 1 |
| Ph.oCisRun [

i

Trip

Note: Runis™ v ", Stopis™Xx".
IA IB IC—Measured current Iset—Pickup current T—Delay time

50G/50N Sensitive Earth Fault (SEF)

When the switch is set at the end of the line, the zero sequence current can be used
to protect the earth fault when the capacitance of the power supply side to the earth
is large and the capacitance of the load side to the earth is small.

When the switch is set at the end of the line, the ground fault on the load side of the
switch can be detected only according to the zero sequence current. However, if
there is a large capacitance to ground on the load side, it is possible to detect the
zero sequence current and misoperate when there is a ground fault on the power
side. Therefore, it is necessary to judge the direction and fault point of the grounding
current according to the amplitude of the zero sequence current and the phase angle
between the zero sequence voltage and the current, in order to prevent this
unnecessary misoperation.
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The angle between zero sequence directionality refers to the angle between zero
sequence voltage and zero sequence current and the angle of zero sequence current
leading to zero sequence voltage. When conducting zero sequence directionality test,
the starting angle and ending angle of zero sequence action interval can be modified.
After being put into operation, the zero sequence current in the section shall exceed
the set value, and the zero sequence directional protection can only operate,
otherwise it will not operate.

For example, the start angle of zero sequence action section is set to 240 ° and the
end angle of zero sequence action section is set to 300 ° . At this time, enter the
“VIEW"” — “Meter” menu to check the angle of IUOan (IUOan is the angle of zero
sequence current ahead of zero sequence voltage). Only when it is between 240 © ~
300 ° and the zero sequence current exceeds the set value, the zero sequence
directional overcurrent will act, otherwise it will not act.

Action Logic diagram:

310>10set

SEF isRun &
Mode (1/2)
310>10set 2]_7 —Alarm/Trip

61<IU0an<B2
Note: Runis™ v ", Stopis™X".
3I0—SEF current I0set—Pickup current T—Delay time

6 1—Start angle 6 2—End angle
IUOan—AnNgle of zero sequence current ahead of zero sequence voltage

H“H

|

|

Note: If zero sequence directional overcurrent protection is required, it shall be
specified when ordering. The normal delivery is zero sequence overcurrent without
direction.

79 Auto - Reclose (Reclose)

A high proportion of faults on an overhead line network are transient and can be
cleared quickly by high speed tripping followed by an automated circuit breaker
reclose sequence.

The function provides phase fault and earth fault/sensitive earth fault sequences of
up to 5 trip i.e.4 reclose attempts before lockout, and the charging period of the
reclose is 10 seconds.
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Action Logic diagram:

| Ph.OC Trip |
|
|

| Reclose is Run

| Reclose count #0 |

& Close

Reclose unlock

| |
J
| Manual trip I
| Remote trip | q
| |

After close>10S

Note: Runis™ v ", Stopis™Xx".
Reclosing acceleration (Recl.ACC)

When switching on reclosing acceleration, if accidents happened in 3S after the
reclose is operated, the phase over current protection will accelerate the operation.
Action Logic diagram:

7
21

IB>Iset

[ toorser :
T B

Trip

| After reclose <35

|
|
| Recl.ACC is Run I

Note: Runis™ v ", Stopis“X".
IA IB IC—Measured current Iset—Pickup current T—Delay time

Manual closing acceleration (Manu.ACC)

When switching on manual closing acceleration, if accidents happened in the exit
time after operated the close, the phase over current protection will accelerate the
operation. The exit time of acceleration can be adjusted.

Action Logic diagram:

IB>Iset >1

IC>Iset

| Manual/Remote Close li& =
| After close <Exit time }—

| Manu.ACC is Run I

W

Trip

Note: Runis™ v ", Stopis™Xx".
IA IB IC—Measured current Iset—Pickup current T—Delay time
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Prepaid (Optional features)

It is used to connect the dosing tank, the device will control the CB to trip when the

dosing tank is in deficit.
Action Logic diagram:

[ CBin closed position

}—

&

| Prepaidisrun |

Note: Runis™ v ", Stopis™Xx".

3.2 Constant Value Parameters

All values are given primary side.
Under Voltage (Ph.UV)

Description Setting range
Operating mode 1. Trip 2. Alarm

PH.UV Pickup voltage 0.01~42KV
Delay time 0~99.99S

Power on

Description Setting range

Power on Pickup voltage 0.01~42KV
Delay time 0~99.99S

Over Voltage (Ph.OV)

Description Setting range
PH.OV Pickup voltage 0.01~42KV
Delay time 0~99.99S

51C Cold Load Pickup (Cold load)

Description Setting range
Pickup current 1~6000A
Coldlioad o ey e 0~99.995

50P Phase Fault (Ph.0OC)

Description Setting range
PHOCL (o tme 09558
PO oy tme. 099558

50G/N Sensitive Earth Fault (SEF)

Description Setting range
SEF Operating mode 1.Alarm 2.Trip
Pickup current 0.1~999.9A

17

Trip

Step length

0.01KV
0.01S

Step length
0.01KV
0.01S

Step length
0.01KV
0.01S

Step length

0.1A
0.01S

Step length

0.1A
0.01S
0.1A
0.01S
0.1A
0.01S

Step length

0. 1A



Delay time
Start angle
End angle

79 Auto - Reclose (Reclose)

Description

Reclose count

Reclose  pelay time
Reset time

Reclosing acceleration (Recl.ACC)

Description

Pickup current

RechACC Delay time

0~600S/M 0.1S/M

Manual closing acceleration (Manu.ACC)

Description
Exit time
Manu.ACC  Pickup current
Delay time

Prepaid (Optional features)
Description

Prepaid Delay time

0~360° 1°

0~360° 1°
Setting range Step length
1:0ne 2:Two 3:Three 4:Four
0~99.99S 0.01S
1.2~180S 0.1S
Setting range Step length
0.1~6000A 0.1A
0~9.99S 0.01S
Setting range Step length
0.1~9.99S 0.01S
0.1~6000A 0.1A
0~9.99S 0.01S
Setting range Step length
0~99.99S 0.01S
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goutosoEEs

19: 31: 45
Ia= 0.000 A
Ib= 0.000 A
Ic= 0.000 A

////‘.N RWH-151

ROCKWILL

The operator interface is designed to provide a user friendly method of controlling,
viewing menus, entering settings and retrieving data from the relay. 11 buttons are
provided for navigation around the menu structure.

4.1 LEDs

Operation Status
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LED Categories

Name  describe

Run equipment
running

DT communication

ALM alarm

ON closed position

OFF Opened
position

ACT action

79 reclose

OC Over current

SEF Ground fault

86 lockout

4.2 Keypad

The main keys

Color

Green

Green

Yellow

Red

Green

Red

Red
Red
Red

Red

ON

crash

No communication

Device failure or
protection alarm

Switch is on

Switch is off

Protective action

Reclose export
Over current action
Ground fault action

Reclosing lockout
alarm

LED Status
OFF

crash

No communication

Running normally

Switch is not on
Switch is not off
No protective
action

Normal

Normal

Normal

Normal

User actions are mainly concentrated on the operation panel.

20

Flashing

Working
properly

Normal
communication



Key Function

Increase the number

Reduce the number

Move up or page up

Move down or page down

Move left

Move right

Return to the superior or Cancel the operation

Enter the menu of confirm the operation

When you press the button, the buzzer of device will sing make a sound, so that
the operation is valid; if not, please do it again.
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Operation buttons
Key Function

Touch reset button, you can reset protect information

Touch closing button, close switch

Touch tripping button, trip switch

When you press the button, the buzzer of device will make a sound, so that the
operation is valid; if not, please do it again.

Note: When you press the closing-button or tripping-button, you must make sure the
device is unlock; if the lockout-light is on, please press the reset-button to reset the
device, so that you can close or trip the switch.

4.3 LCD

A 4 line by 16 character liquid crystal display with power save operation indicates the
relay identifier, settings, instrumentation, fault data and control commands.

4.4 The Main Menu

Press “Enter” when on the main screen, as shown below, including "EDIT” and
“VIEW” menu item. Select the corresponding menu item with the [<] key, [—] and
press "Enter" button to enter the corresponding sub-menu, press the “ESC” key to
return to the previous screen.

Primacy Menu

22



4.5 Submenu
Edit submenu

Choose the edit options, the screen will enter the submenu of the Edit menu, as
shown below, the submenu includes "Relay”. “Para”. “Chnl”. “Clr”". “Time”.
“Comm”. “Fac”. “Test”.

Submenu of edit

Enter “Relay” submenu, you can modify the protection feature.

Enter “Para” submenu, you can modify or view other parameters. Like
communication address, baud rate, password, trip and close pulse time.

Enter “Adj.” submenu, current and voltage values can be corrected,
press the function key "Enter" to be modified.

Enter “Clr.” submenu, you can clear out the trip report, the alarm
report, the SOE report, the count report and all report.

Enter the “Time” submenu will modify or check the time.

Enter "Comm” Sub-menu, choose the way to communication, it include
“GSM"and “GPRS".

Enter “Fac.” Sub-menu, modify and view the factory settings.
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View submenu

Choose the view options, the screen will enter the submenu of the View menu, as
shown below, the sub-menu includes “Meter”, “"RPT”, “Relay”, “Input”, “Ver”.

View submenu

Enter “Meter” submenu, you can view the primary side measurement
data include: PT voltage, phase current, zero sequence current,
frequency, phase angle.

Enter "RPT” submenu, you can view trip report, alarm report, SOE
report, count report.

Enter “Relay” submenu, you can view each protection feature is
invested and set up the parameters

Enter the “Input” submenu, you can view the input signal. The input
signal includes: Breaker close, Prepaid open, Prepaid close, Spring
ready.

Enter “Ver” submenu, you can view the product model, serial
number and date of manufacture.
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4.6 Entering the password interface

According to the above operation, before entering each item will first enter a
password input interface to prevent professional staff misuse. The device original
password is “0099”, as shown below, press [<] and [—] keys to switch, press the
[+] and [-] keys to increase and decrease the number of line with the correct
password press “Enter” button to enter.

Enter Password:

Mooo

Password interface

4.7 Relay setting

Select the “"Relay” in the Edit submenu item, press the function key “Enter” to enter
the password screen, enter the correct password to enter the “Relay” submenu, as
Shown below, each item has a checkbox and set values.

1

1

. Ph.OC1: instantaneous overcurrent Protection
. Ph.OC2: definite time overcurrent protection

. Ph.OC3: overcurrent protection

. SEF: sensitive earth fault protection

. Cold Load: cold load pickup

. Reclose: OC reclose

. Recl.ACC: reclosing acceleration protection

. Manu.ACC: manual closing acceleration protection
. PH.OV: overvoltage protection

10. PH.UV: low voltage protection

11. Power on: power on protection

Power Alm: 12. Prepaid: debt protection

23. Power Alm: stored energy alarm

U

Cold load:
Reclose:

Recl .ACC:
Manu.ACC:

Ph.OV:
Ph.UV:

Power on:
Prepaid:

) [ I@ 7]
OCoONOUThA, WN

T A D I T
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Three sections phase overcurrent

Select Ph.OC menu
shown below:

option press “Enter” key to enter, operational processes as

Step 1: Setting the overcurrent protection
current value, the current value can be
between 0.1A ~ 6000A.

Step 2: Setting the overcurrent delay time, the
delay time can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of simple overcurrent protection setting

Note: Here are three-stage overcurrent protection, the use of the other two are the
same.

Sensitive earth fault

Select SEF menu
shown below:

option press “Enter” key to enter, operational processes as

SIER(817/458)
Operating mode:
Se il -4

SIEF(A]S)

Pickup current:
f20.0 A

Sep: 00,1 -999.9

SIEIR(87/45))
Delay time:

[§oo.2 s

SEF(4/5)

Start angle:
A4o0

Scp:000 - 360

SIEE(S/i5!)

End angle:
Eoo

Sic p%0i010°-"3 6/0

Step 1: Choose the SEF operating mode (1:
Alarm 2: Trip 3: Direction alarm 4: Direction

trip).

Step 2: Setting the SEF protection current
value, the SEF current value can be between
0.1A ~ 999.9A.

Step 3: Setting the SEF delay time, the delay
time can be between 0 ~ 600.0S/M.

Step 4: Setting the SEF start angle, the angle
can be between 0 ~ 360.

Step 5: Setting the SEF end angle, the angle
can be between 0 ~ 360.

Note: 1.Press [ | ] key to switch to next
screen, press the [+] and [-] keys to switch
the modified current value and delayed time.
2. Step 4 and step 5 only need to be set when
zero sequence direction overcurrent is
required.

The operational processes of SEF protection setting
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Cold Load

Select Cold Load menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the cold load protection
current value, the current value can be
between 1A ~ 6000A.

Step 2: Setting the cold load delay time, the
delay time can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to modified
current value and delayed time.

The operational processes of cold load protection setting

Automatic reclosing (Reclose)

Select Reclose menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Choose the automatic reclosing times
(1: One, 2: Two, 3: Three, 4: Four).

Step 2: Setting the 1st delay time, the delay
time can be between 0S ~ 99.99S.

Step 3: Setting the 2nd delay time, the delay
time can be between 0S ~ 99.99S.

Step 4: Setting the 3rd delay time, the delay
time can be between 0S ~ 99.99S.

Step 5: Setting the 4th delay time, the delay
time can be between 0S ~ 99.99S.

Step 6: Setting the automatic reclosing reset
time, the reset time can be between 1.25~
180.0S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
mode and modified delayed time/reset time.

The operational processes of automatic reclosing setting
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Reclosing acceleration (Recl.ACC)

Select Recl.ACC menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the reclosing acceleration
protection current value, the current value can
be between 0.1A ~ 6000A.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of reclosing acceleration protection setting

Manual closing acceleration (Manu.ACC)

Select Manu.ACC menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the manual closing acceleration
exit time, the exit time can be between 0.1S ~
9.99S.

Step 2: Setting the manual closing acceleration
protection current value, the current value can
be between0. 1A ~6000A.

Step 3: Setting the delay time, the delay time
can be between 0S ~ 9.99S.

Note: Press [ + ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified current value and delayed time.

The operational processes of manual closing acceleration protection setting
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Over voltage protection (Ph.OV)

Select PH.OV menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Setting the overvoltage protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of overvoltage protection setting

Low-voltage protection (Ph.UV)

Select PH.UV menu option press “Enter” key to enter, operational processes as
shown below:

Step 1: Choose the low voltage protection
operating mode (1: Trip 2: Alarm).

Step 2: Setting the low voltage protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of low voltage protection setting
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Power on

Select Power on menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the Power on protection
voltage value, the voltage value can be
between 0.01KV ~ 42.0KV.

Step 2: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press [ | ] key to switch to next screen,
press the [+] and [-] keys to switch the
modified voltage value and delayed time.

The operational processes of Power on protection setting

Prepaid (Optional features)

Select Prepaid menu option press “Enter” key to enter, operational processes
as shown below:

Step 1: Setting the delay time, the delay time
can be between 0S ~ 99.99S.

Note: Press the [+] and [-] keys to switch the
delayed time.

The operational processes of prepaid protection setting

4.8 Save parameter

After setting, press “"ESC” key to exit, if modified below figure will show. If you need
to save press “Enter” key and input password, otherwise press “ESC” key.

Save:Press Enter

Exit:Press Esc
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4.9 Parameter set

Press the EDIT — Para, enter the “parameter set”. Press the [+] and [-] keys to
modified parameter value.

CT, CTO rate set

CT rate is the three phase current rate.
The value of CT ratio is equal to the
primary side current value divided by
the secondary side current value.

CTO rate is the real zero sequence
current rate. The value of CTO ratio is
equal to the primary side current value
divided by the secondary side current
value.

Parameter set PT rate is the power voltage rate. The
PT rate value of PT ratio is equal to the primary
m45 side voltage value divided by the
Sc D! 001 -999 secondary side voltage value.

Note:

1 Different current transformer, CT ratio becomes different.

2 Different current transformer, CTO ratio becomes different.

3 Different PT power voltage transformer, PT ratio becomes different.

Wiring mode set

Parameter set Phase current wiring mode.

CT Numbe

Thr.: Three-phase
thr.

Two: Two-phase

Parameter set zero sequence current wiring mode.

Zero-cur Comp: Synthetic zero sequence

Comp

Real: Real mining zero sequence

Note: The wiring mode must be the same as that of the circuit breaker.
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Close and trip pulse time set

“Close pulse time” is the discharge time for close coil. “Trip pulse time” is the
discharge time for trip coil.

Note: Please do not modify the trip and close pulse time.

Password set
The device initial password is “0099”,
the password for the user to modify
from the “0000” ~ “9999”, when revised

press “Enter” key to confirm, enter the
password before the modification.

Set the communication parameter

Name Setting range  Step length Description
0: Close this channel

it S it ; 1: Open this channel
Comm1 Baud 0~38400 1 Default 9600

1: IEC60870-5-101

2: IEC60870-5-104
Comm1 Protocol 1~4 1 3. DNP3.0

4: MODBUS
Comm1 Balance 0~1 1 O UiltlEleel

1: Balance
Comm1 Address 1~65535 1 Source address
Comm1 Report 0~65535 1 Destination address

o 0: Do not upload actively

Comm1 Upload 0~1 1 1: Active upload

0: Close this channel
el S s ; 1: Open this channel
Comm2 Baud 0~-38400 1 Default 9600

1: IEC60870-5-101

2: IEC60870-5-104
Comm2 Protocol 1~4 1 3. DNP3.0

4: MODBUS
Comm2 Balance 0~1 1 0: Unbalanced

1: Balance
Comm2 Address 1~65535 1 Source address
Comm2 Report 0~65535 1 Destination address
Comm2 Upload 01 1 0: Do not upload actively

1: Active upload
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Signal type

Control type

Meter type

Address len

COT len

I factor

I deadband

10 factor

10 deadband

U factor

U deadband

U0 factor

U0 deadband

P factor

P deadband
COS factor

COS deadband
OTH factor
OTH deadband
CLASSA
CLASSB

Select Timeout
Confirm Link
Link Retry Times
Link Timeout
Upload Confirm
Upload Timeout
Upload Retry Times
Auto Refresh
Refresh time

1~2

1~2

0.01~100
0.1~1000
0.01~100
0.1~1000
0.01~100
0.1~1000
0.01~100
0.1~1000
0.01~100
0.1~1000
0.01~100
0.1~1000
0.01~100
0.1~1000
0~3

0~3
0~30
0~1
0~15
0~50
0~1
0~50
2~10
0~1
0~65535

0.01
0.1
0.01
0.1
0.01
0.1
0.01
0.1
0.01
0.1
0.01
0.1
0.01

33

: Single point

: Double point

: Single point

: Double point

: Normalized telemetry

NFE, NN

quality

3: Standardized telemetry

4: Short floating point telemetry
Address length

1: 1 byte 2:2 byte

COT length

1: 1 byte 2:2 byte

Phase current multiplier

Phase current dead zone

Zero sequence current multiplier
Zero sequence current dead zone
Line voltage multiplier

Line voltage dead zone

Zero sequence voltage multiplier
Zero sequence voltage dead zone
Power multiplier

Power dead zone

COS multiplier

COS dead zone

Other multiplier

Other dead zone

Class for analog event data
Class for digital event data
Select/operate time-out

Enable confirm data link

Data link retries times

Seconds to data link time-out
Enable upload confirmation
Seconds to upload time-out
Upload retries times

Enable automatic reset of events
Seconds to automatic reset event

Normalized telemetry without



4.10 Calibration

Select the Edit submenu in “Adj.”, press “Enter” key to enter into the password
screen, enter the correct password to enter the “Adj.” submenu, press the [+] and [-]
keys to correct the value of current and voltage.

Note: All voltage and current values in the factory have been corrected before.
Please do not change the parameter values.

4.11 Clear report

Select the Edit submenu in “CIr”, press “Enter” key to enter, as shown below:

1.Clear trip Select "1": Clear the trip report.

2.Clear alarm Select “2": Clear the alarm report.
3.Clear SOE
4 Clear count Select “3": Clear the SOE report.

5.Clear all Select "4": Clear the count report.

Select “5": Clear the all report (include trip
record, alarm record, SOE record and count
record) .

4.12 Factory setting

All the values in the factory have been corrected before. Please do not change the
values.

4.13 View primacy meter

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “"Meter” option to press “Enter” key to enter the “Primacy Meter” submenu,
you can view all the primacy meter value.
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. Ia: Primary side current of phase a

. Ib: Primary side current of phase b

. Ic: Primary side current of phase ¢

. 310: Zero sequence primary current

. UAB: Line voltage UAB primary side value
. UBC: Line voltage UBC primary side value
. F: Frequency

. P: Active power

. Q: Reactive power

10. AP: Apparent power

11. COS: Power factor

12. Iaang: Angle of phase a current

13. Ibang: Angle of phase b current

14. Icang: Angle of phase c current

15. I0ang: Angle of zero sequence current
16. Uaang: Angle of line voltage UAB

17. Ubang: Angle of line voltage UBC

OoNOOTULTh~hWN

4.14 View SOE

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select “"RPT"” option press “Enter” key to enter the "RPT” submenu, you can view the
SOE record events, recording events include: trip signal, alarm signal, telemetry
signal (circuit breaker status, whether the manual or remote operation, fault trip,
time and date, etc.) and count signal (the count of trip).

0C= 4
SEE= 1

Manual= 10
Remote= 0
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4.15 View relay and setting

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can

view all the protection is enabled or disabled, select the option press “Enter”
key to enter the value you can view each protection, press the arrow keys to switch
screens.

4.16 View input signal

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Input” option press “Enter” key to enter the “Input” submenu, you can
view the state of input signal.

Input show Input show Input show
PrepaidC PrepaidT Remote

Close- Bak Bak
S pIRINGE Bak Bak

4.17 View version information

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then
select the “Ver” option press “Enter” key to enter the “Ver” submenu, You can view
the device type, version number, production date, and device ID.

Device type: Production date:
RWC-4LC 20053- 0101

Version: Device ID:
2.5 01912-26601
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Chapter 5: Installation and Maintenance

As show below, the installation mode is cabinet door imbedded. The wiring terminal
wiring comes out of the backboard of the device.

e 185 [ —
_ 22
=
Y
O O O J
e /
\k* 189 ;

122

Recommended opening size
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6.1 Decommission

Shut-down Power Supply

Shut-down Device Power Supply: Turn off external power supply switch of the device.
Disconnect All Power Cables

Disconnect all power cables connected to the device.

Danger: Before disconnecting all power cables connected to the device power
module, it must confirm that the external power switch is turned off to avoid danger.

Danger: Disconnecting all power cables connected to the device alternating current
module, it must confirm that the equipment corresponding to input alternating
component has stopped operation to avoid danger.

Dismantle from Display Cabinet

When the above steps are completed, loosen the fix screws and dismantle the device
from the display cabinet.

Danger: When neighboring equipment is in operation, it must strictly confirm the
safety distance between the dismantled device and other device in operation and
unskilled professional shall take particular caution.

6.2 Disposal

When dispose decommissioned device, please follow relevant regulations of the
country where the product is used for the disposal of scrapped electronic products.

Caution: It must strictly adhere to relevant regulations of the country where the
product is used for the disposal of scrapped electronic products.
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D1

1 |10

2 |ION D

3 |IN 4IJ

4 |ic TAc >

= B TAb e

6 |1A TAa e

D2

1 |PTL

2 |PTL Secondaly
side of PT

3 |PTN (AC220V)

4 |PTN

5 |Backup

6 |Backup

7 |Backup

8 |Backup

9 |Backup

10 |Backup
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D4

1  |Coll common(AC220V-N)

2 |Closing coil(AC220V-1) I
3 |Opening col(AC220V-L) | - _/IJL
4 |Posltlon common(24V+)

5 |Posltlon common(24V+)

6 [

DL

7 |IN2(Switch position) ~1

8 |IN3(Spring posltion) Cﬁ]

a9 |ind
10 |ins
11 |ne
12 |in7
D3

1 |EGND :l

3 |485A
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